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Chapter 6 

Keeping a Project Organized 
with Sheet Sets 
It’s rare to have a drawing project fit on one sheet. Most CAD projects require multiple sheets, sometimes 
numbering in the hundreds. With multiple sheets in a project, you often spend a fair amount of time 
checking cross-references between the drawings and making sure that information like sheet titles is 
correct. 

Even the smallest project requires some coordination of cross-references between drawings in a  
set and checking for consistency across sheets. For example, a floor plan of a house will have callout 
symbols that direct you to a sheet with building elevations, construction details, or door and  window 
schedules. As a CAD user, you eventually spend a lot of time just making sure that you have your set of 
drawings in the proper order and labeled correctly. Checking a set of drawings for continuity and cor- 
rectness is a time-consuming job, and errors can easily creep in. 

To help make your sheet coordination efforts easier, AutoCAD® 2017 software offers the Sheet Set 
Manager. 

In this chapter, you will learn to: 

• Understand sheet sets

• Create a sheet set from an existing project

• Manage title blocks and cross-references

• Customize sheet sets

• Archive, publish, and eTransmit sheet sets

Understanding Sheet Sets 
The Sheet Set Manager is a tool that keeps track of all the drawings in a project. It also helps maintain  
the integrity of cross-references between sheets in a set of drawings by automatically updating sheet 
numbers throughout a set as sheets are added or moved. The Sheet Set Manager won’t replace a careful 
check of a set of drawings before they’re released for consumption, but it will reduce the amount of time 
you spend on coordinating and checking the  drawings. 

Sheet sets and the Sheet Set Manager can be a bit difficult to understand clearly, so in the following 
sections, take a moment to get a better idea of what sheet sets are all about. 
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Organizing by Reference Files and Sheet Files 
To understand how sheet sets work better, you should consider the methods used to organize AutoCAD 
files. One common method for organizing files is to separate drawings into two categories: reference  
files and sheet files. You can think of reference files as the data sources. These are the drawing files that 
contain the core drawing geometry of a project. For example, they might be the floor plan drawings that 
contain the paving, finish, ceiling, and power information, all drawn in Model  Space. 

Sheet files are files that represent the actual printed sheets or pages in the drawing set. Sheet files 
include title block information as well as the different views of the reference files needed for the sheet. 
They also include view titles and scale  information. 

You use one layout view in the sheet file for each physical sheet that eventually gets printed. The ref- 
erence files are included as Xrefs in the sheet files with the appropriate views and layers set up for each 
sheet. 

For example, you might have one sheet file called A1 Floor Plan.dwg that has a title block in its 
layout view. That layout view has a viewport containing a view of an Xref floor plan file. Another sheet 
file called A2 Enlarged Plan.dwg might contain the same Xref, but with a layout view including 
multiple viewports to show a more detailed set of views of the plan. 

The Sheet Set Manager can take this reference/sheet system of file organization and automate  it. 
Without the Sheet Set Manager, you must create the sheet file, import the reference file, and then add a 
title block, viewport, and labels to produce a finished sheet. The Sheet Set Manager automates many of 
the fussy details of creating and maintaining the sheet  files. 

 
 

 
 
 

Managing Your Files with Sheet Sets 
Sheet sets also serve as a way to gain an overview of your drawing set in a way similar to using the table 
of contents of a book. When you use the Sheet Set Manager, you can view a list of all the drawings in 
your project and quickly find and open the drawing on which you need to do work. 

You can think of the Sheet Set Manager as a database that contains information about the drawings  
in the set. It uses a file with the .dst filename extension to store this information. Like a database, this 
file is updated automatically whenever you make changes to the sheet set. It doesn’t wait for you to save the 
sheet set data manually. In fact, you won’t see a Save option in the Sheet Set Manager. 

The Sheet Set Manager can change multiple drawing files whenever a change affects the entire set. 
For example, if there is a change in the project information in the title block, you can update all the title 
blocks in the set by making a single change in the Sheet Set Manager. The Sheet Set Manager can keep 
track of title-block data such as submission dates, drawing titles, people who have worked on the indi- 
vidual drawings, and related  information. 

Don’t Limit Your Use of Sheet Sets 

The example given here illustrates one way that sheet sets can be used. You don’t have to organize 
your drawings in this way to take advantage of sheet sets when you’re working on projects in 
the real world. You can use sheet sets to organize any project that uses multiple drawings. For 
example, we’ve seen sheet sets used to help trainers keep track of tutorial files. Others have used 
it to keep track of their AutoCAD presentations. 
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Finally, the Sheet Set Manager can help simplify the printing of whole sets of drawings by auto- 
matically setting up the AutoCAD Publish feature. It can help automate your archiving tasks and help 
collect all the necessary files to send your set to a different location for  editing. 

 

Creating a Sheet Set from an Existing Project 
As an introduction to sheet sets, you’ll first create a sheet set from an existing set of drawings. You’ll 
then see how your sheet set can be used as a way to keep track of the files in a project. 

This example is a small house remodel with some basic drawings. Although the project is small, it 
will show you the main elements of the Sheet Set Manager. 

 
Using the Create Sheet Set Wizard 
The Create Sheet Set Wizard is the main tool you’ll use when creating a sheet set. It offers a step-by-step 
method for setting up new sheet sets and, as with all wizards, you can back up and make changes along 
the way. Here’s how to use it: 

1. In AutoCAD, click the Sheet Set Manager tool on the View tab’s Palettes panel to open the Sheet 
Set Manager (see Figure bc6.1). (You may see the title bar and tabs reversed from the example 
shown here, depending on whether the palette is located on the left or right side of the AutoCAD 
window.) 

 

Figure bC6.1 
The Sheet Set 
Manager 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the drop-down list at the top of the palette, and select New Sheet Set to start the Create 
Sheet Set Wizard. 
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3. Click the Existing Drawings radio button, and then click Next. The Sheet Set Details screen of the
wizard appears (see Figure bc6.2). 

Figure bc6.2 
Naming a new 
sheet set 

4. Enter My Existing Sheet Set for the name of the sheet set.

5. Enter My first sheet set using samples from Mastering AutoCAD in the Description text box.

6. Click the Browse button to the right of the Store Sheet Set Data File (.dst) Here text box.

7. Browse to and open the location of the Sheet Set Sample 1 folder, which is in the
\Sample Files\7-Keeping a Project Organized with Sheet Sets\Sheet
Set Sample 1 folder.

8. Click Next. The Choose Layouts screen of the wizard appears.

9. Click the Import Options button to open the Import Options dialog box (see Figure bc6.3).

Figure bc6.3 
Options for import- 
ing layouts 

You’ll Need at Least One File Open 

The Sheet Set Manager won’t allow you to create a new sheet set unless a drawing is currently 
open. 
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10. Make sure all three options are selected, and then click OK. You’ll learn more about the options 
in this dialog box in the next section. 

11. Click the Browse button, and then locate and select the Sheet Set Sample 1 folder you 
selected earlier. After you’ve selected the folder, click OK to see the list of subfolders in that 
folder. 

 
 

 
 

12. Click the plus signs to expand the listings for Architectural and Structural (see Figure 
bc6.4). You see the drawings in those folders. Expand the list for each drawing to see the layouts 
available in each drawing. You can select and deselect the layouts and drawings to include in the 
sheet set. Your list may not be in the same order as shown here, but the contents will be basically 
the same. 

 

Figure bc6.4 
Browse to the 
drawings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. Remove the check mark next to the Resource folder shown in the list. You don’t want to include 
the Resource folder because that contains the files used as Xrefs in the Paper Space files. For this 
exercise, you want to select only the drawings and layouts that represent the sheets in your  set. 

Setting a Default Location 

You can set a default location for your sheet sets by using the Files tab of the Options dialog box. 
See Appendix B, ‘‘Installing and Setting Up AutoCAD,’’ for more on the Options dialog  box. 
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14. Click Next. You see the last screen of the wizard, which displays the statistics of your new sheet 
set. It shows only the layouts from the selected drawings because the layouts are the focus of the 
Sheet Set Manager. Click Finish to exit the wizard. AutoCAD creates a new sheet set. 

15. Select the Sheet List tab in the Sheet Set Manager to view its contents. The Sheet Set Manager now 
shows a list of the drawings in the Sheet Set Sample 1 folder (see Figure bc6.5). It didn’t display 
the main folder called Sheet Set Sample 1 because the Ignore Top Level Folder option is on (see 
“Formatting Sheet Sets with the Import Options” later in this chapter). 

 

Figure bc6.5 
The list of drawings 

 
 
 
 
 
 
 
 
 

 

 
 

The sheet list in the Sheet Set Manager shows the name of each existing drawing file with the layout 
name appended. This helps you identify both the filename and the layout associated with the sheet. As 
you become more familiar with the Sheet Set Manager, you can choose to display only the layout name. 

 
Exploring the Sheet Set Manager 
Although you have more work to do before the sheet set becomes a useful tool, it’s complete enough that 
you can explore some features of the Sheet Set Manager before you add the resource  drawings. 

 
Formatting Sheet Sets with the import Options 
In step 9 of the preceding exercise, you saw the Import Options dialog box. This dialog box lets you con- 
trol how files and folders are organized in the Sheet Set Manager and how the sheets are assigned names. 
Here is a list of these options: 

Prefix Sheet Titles With File Name The Sheet Set Manager displays only the layout names in its 
sheet list. With this option selected, the Sheet Set Manager adds the name of the file containing the 
layout as a prefix to the sheet name. If you want only the layout name to appear in the sheet list, turn 
off this option. 

Create Subsets Based On Folder Structure If you set up your file structure to separate your proj-  
ect folder into subfolders (such as architectural, mechanical, structural, and civil), you can retain that 

The Sheet Set Manager Can Change 

Your Sheet Set Manager may look slightly taller or narrower than the one shown here because it 
can be resized by stretching its borders. The order of the drawings may also be different, but the 
same drawings will be shown. You can click and drag items in the list to change their order. 
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structure in the Sheet Set Manager by selecting this option. Turn off this option if you want the Sheet 
Set Manager to display all the sheets in your project in a single column with no  subfolders. 

Ignore Top Level Folder  When you select a project folder containing your drawings for the sheet  
set and subfolders are used to keep separate categories of drawings organized, this option causes   
the Sheet Set Manager to ignore the top-level folder and display only the subfolders. This is useful    
if you have one main folder that contains subfolders of your  drawings. 

The sample folders you used for the previous exercise were set up to demonstrate how these options 
work. All the options were turned on. As a result, the Sheet Set Manager displayed the sheets with two 
main categories, Architectural and Structural, reflecting the folder structure of the sample project files. 
The sheet names showed the layout names appended to the drawing filenames because the Prefix Sheet 
Titles With File Name option was turned on. 

 
 

Setting the Sheet Set Properties 

In the Sheet Set Details screen of the Create Sheet Set Wizard is a button labeled Sheet Set 
Properties. If you click this button, the Sheet Set Properties dialog box opens, showing you some 
of the settings that are part of your new sheet set. 

 

 
 

Much of this information describes the location that the Sheet Set Manager will use as you work 
with sheet sets. Also note the Edit Custom Properties button at the bottom of the dialog box. 
This enables you to add or edit some of the properties of the sheet set. This information can be 
edited in the Sheet Set Manager, as you’ll see  later. 

 
 

Previewing and Opening Drawings in the Sheet Set Manager 
You can view quite a bit of information about the drawings in your list. You can also open a file by dou- 
ble-clicking its name in the sheet list. Here’s how: 
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1. Select 1 – A1 Plan – 22x17 Arch Layout – Plan from the sheet list. A panel appears (see Figure
bc6.6) and displays a description of the sheet, including a thumbnail view and the name, location,
and size of the file that contains the sheet.

2. Double-click the 1 – A1 Plan – 22x17 Arch Layout – Plan listing. AutoCAD opens the  drawing.

Figure bc6.6 
The flyout informa- 
tion panel 

Adding the Resource Drawings 
Now you’ll add the resource drawings to the Sheet Set Manager’s sheet list. Remember that the resource 
drawings are the source Xref files for the sheet drawings. By adding them to the Sheet Set Manager, 
you’ll have ready access to all the files in your project: 

1. Select the Model Views tab in the Sheet Set Manager. The palette changes to show the Locations
list. Right now, nothing is shown except the Add New Location  listing.

Why Not include the Resource Folder? 

You may recall that earlier, in the section ‘‘Using the Create Sheet Set Wizard,’’ we asked you not 
to include the Resource folder. That’s because the Create Sheet Set Wizard attempts to create
a sheet from all the files in your selection. You don’t want to include your resource files as sheets, 
but you do want to include them as resources. 
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2. Double-click the Add New Location item. A standard file dialog box opens. 

3. Locate and select the Resource subfolder under the Sheet Set Sample 1 folder that you’ve 
been using; then click the Open button. The Sheet Set Manager displays the list of drawings in that 
folder. 

4. Double-click plans.dwg. You may see an AutoCAD alert message telling you that the file is 
currently in use. Click Yes. The plans file opens, showing you the source drawing for the 1 
– A1 Plan drawing. 

Your sheet set now contains a list of all the files in the project. You can use the Sheet Set Manager to keep 
track of your AutoCAD files as the project progresses. If you need to plot all your sheets, archive them, or 
move them, you can do so with relative ease by using options described toward the end of this chapter. 

 
Adding New Sheets to Your Sheet Set 
Now that you’ve created a sheet set from an existing project, as the project continues you’ll want to use 
the Sheet Set Manager to create any new sheets that you want to add to your set. Doing so ensures that 
the Sheet Set Manager knows about all the files in the project at all  times. 

But before you start to add new sheets, you need to do a bit of setup. You’ll need to make sure the 
Sheet Set Manager knows which template file to use for any new sheet drawings you add to the  set. 

 
Pointing to a Sheet Template 
The following exercise shows you how to tell the Sheet Set Manager which template file to use for new 
sheets: 

1. Select the Sheet List tab of the Sheet Set Manager. 

2. Right-click My Existing Sheet Set at the top of the Sheet List, and then select Properties. The Sheet 
Set Properties dialog box opens. (See the sidebar “Setting the Sheet Set Properties” earlier in this 
chapter.) 

 
You see three sections: Sheet Set, Project Control, and Sheet Creation. The Sheet Set section offers 
information about the current sheets and sheet set. The Project Control section lets you add 
information regarding the sheet set, such as the project name, number, and milestones. The Sheet 
Creation section lists information about new sheets. 

3. Click the Sheet Creation Template option in the Sheet Creation section. If you can’t read the names 
of the options, hover your cursor over a name and the full option name will appear as a tool tip. A 
Browse button appears to the right of the option. 

                  4.  Click the Browse button to open the Select Layout As Sheet Template dialog box. 

The Drawing Template File Name text box shows the location of the current default file from 
which a new sheet will be derived. That default location is as follows: 

 
C:\Users\User Name\AppData\Local 
\Autodesk\AutoCAD 2017\R21.0\enu 
\Template\SheetSets\Architectural Imperial.dwt 
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Also note that a layout name is listed in the Select A Layout To Create New Sheets list box. 

5. Continue to select a template file. Click the Browse button to the far right of the Drawing Template
File Name text box to open the Select Drawing dialog box. This is a standard file dialog box.

6. Browse to the \Sheet Set Sample 1\Resource folder, select the 22x17 Arch
.dwt file, and then click Open. This is the template file used for the sheet drawings of the set with
which you’ve been working.

7. Back in the Select Layout As Sheet Template dialog box, select Architectural Title Block from the
Select A Layout To Create New Sheets list and then click OK. Click OK in the Sheet Set Properties
dialog box.

8. A confirmation window asks whether you want to apply the change you made to all nested sub-
sets. Click Apply Changes To Nested Subsets.

You’ve just set up your sheet set to point to a custom template that contains the title block for any 
new sheet files you may create. The last step points out a feature you’ll want to know  about. 

In this exercise, you set the 22x17 Arch.dwt template file as the file the Sheet Set Manager uses
for all new drawings. This template is just a standard AutoCAD template created for this exercise. If you 
prefer, you can set up the Sheet Set Manager to use different template files for new sheets in the sheet 
subsets. For example, you can have one template for the Architectural subset and a different one for the 
Structural subset, if they require different title  blocks. 

To set up the template for the subsets, follow the steps in the previous exercise, but instead of right- 
clicking My Existing Sheet Set, select the subset name. In the Sheet Set Sample 1 sheet set, the name 
would be Architectural or Structural. 

Another option is to select the Prompt For Template option near the bottom of the Sheet Set Properties 
or Subset Properties dialog boxes. As the option name indicates, it prompts you for a template file when- 
ever you create a new sheet. 

Adding a New Sheet 
You’re ready to create new sheets that are based on the same title block as the existing sheets in the   set: 

1. In the Sheet Set Manager, right-click the Architectural subset listing and select New Sheet to add
a sheet under this heading. The New Sheet dialog box opens.

Changing the Template Location 

You can change the default location for sheet set templates in the Files tab of the Options dialog 
box (choose Options from the Application menu). In the Files tab, expand the list for Template 
Settings, select Sheet Set Template File Location, click Browse, and then locate and select your 
sheet set template file location. 
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2. In the Number text box, enter A4, and in the Sheet Title text box, enter Details. As you type, the 
File Name text box is automatically filled in. You can enter a different sheet title if you  like. 

3. Click OK to finish creating your new sheet. Your new sheet appears in the sheet list of the Sheet 
Set Manager. 

4. Double-click the A4 – Details listing in the sheet list. The A4 Details drawing opens to the lay- 
out view. The layout view has been given the name A4 Details, which you can check by clicking 
the Quick View Layouts tool in the status bar or by just looking at the layout  tab. 

5. After reviewing these steps, you can close all the drawings (except for Drawing1) and the Sheet 
Set Manager. 

Before you added the new A4 Details sheet, the Sheet Set Manager was only collecting data about 
your sheet set and displaying that data in the palette. It hadn’t created any new files. In the preceding 
exercise, the Sheet Set Manager created the A4 Details file from the 22x17 Arch 
.dwt template file you specified in the previous exercise, although it didn’t open it until you double- 
clicked it in step 4. 

Now that the A4 sheet has been created, you can edit it as you would any other drawing to include 
Xref files, blocks, or other drawing data. You can then create a viewport in the layout to arrange the 
sheet the way you want. 

 
 

 
 

In a large project with many sheets, managing title-block information can be a lot of work. In the next 
section, you’ll look at some other sheet set features that can automate much of the work of maintaining 
title-block information. You’ll also learn how the Sheet Set Manager can simplify the creation of callout 
bubbles and cross-references between drawings. 

Sheet Sets Are Versatile 

In addition to keeping track of existing and new drawing files in a project, the Sheet Set Manager 
can help you with plotting, archiving, and publishing your set. See the section ‘‘Archiving, 
Publishing, and eTransmitting Sheet Sets’’ later in this  chapter. 
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Managing Title blocks and Cross-References 
You’ve just seen that at a basic level, you can use the Sheet Set Manager to keep track of files in a set of 
drawings. But other features can help reduce the time it takes to create and maintain sheets. In the next 
section, you’ll look at some of the more advanced sheet set features by creating a sheet set based on an 
existing one. 

The Sheet Set Manager can use specially designed template files to automate the creation and man- 
agement of your sheets. You can include fields (see Chapter 11, “Using Fields and Tables,” for more on 
fields) that are sheet set aware, enabling the Sheet Set Manager to update text automatically whenever 
there is a change in the sheet set. In addition, the Sheet Set Manager can use blocks with field attributes   
to automate the process of adding drawing titles and reference symbols, called callout blocks, in the   
Sheet Set Manager. You can customize these templates and callout blocks to fit your style of drawing and 
method of organization. 

 
Creating a New Sheet Set based on an Existing One 
To see firsthand how the Sheet Set Manager can help you manage title blocks and cross-references, you’ll 
create a new sheet set based on an existing sample sheet set created by Autodesk. You’ll use a sample  
sheet set found in the user template folder for new AutoCAD 2017 installations. This sample sheet set uses 
a template file that has the title block and callout blocks already set up and available for use. 

Just as before, you’ll start by opening the Create Sheet Set Wizard. Follow these steps: 

1. If the Sheet Set Manager isn’t already open, click the Sheet Set Manager tool in the View tab’s 
Palettes panel. 

2. Open a new, blank file. Click the drop-down list at the top of the palette, and select New Sheet Set 
to start the Create Sheet Set Wizard. 

3. Make sure the An Example Sheet Set radio button is selected and click Next. The Sheet Set 
Example screen appears. Here you can select from the standard sheet set examples provided by 
Autodesk. Or, if you have a custom sheet set or sheet sets from a third party, you can use the 
Browse To Another Sheet Set To Use As An Example option. 

4. Make sure the Select A Sheet Set To Use As An Example radio button is selected. Then select 
Architectural Imperial Sheet Set from the list box and click Next. The Sheet Set Details screen 
appears. 

5. Enter My Sheet Set in the Name Of New Sheet Set input box. You also have the opportunity to add a 
description of the sheet set in the Description box. The Store Sheet Set Data File (.dst) Here option 
lets you determine where the sheet set data file is stored. You can see the current location by placing 
the cursor over the input box. A tool tip displays the path to the location. This tool tip is useful if the 
path is too long to read from the input box. 

6. Click the Browse button to the right of the Store Sheet Set Data File box, and browse to the loca- 
tion of the sample files for this chapter. Typically, this location is \Sheet Set Sample 2. Click 
Open. 
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7. Back in the Sheet Set Details screen of the Create Sheet Set Wizard, click Next. The Confirm screen
appears. This screen lets you review the settings before you confirm the creation of your sheet set.
You’ve seen this information in the Sheet Set Properties dialog box.

8. Click the Finish button to create your new sheet set. A list of predefined sheet categories appears
in the Sheet List tab of the Sheet Set Manager.

Now, if you check your sample file folder, \Sheet Set Sample 2, you’ll find the My Sheet 
Set.dst file that you’ve just created. As you’ve seen in prior steps, this file holds the infor-mation
regarding the location of the files and custom settings for your sheet set. 

The first sheet set you created was from drawings that already had Xrefs and views set up for the 
sheets. The next section shows you how to use the Sheet Set Manager to create a sheet from scratch, 
including views and Xrefs. 

building a Set of Drawings 
The sheet set you just created is like the framework of your set of plans. It isn’t the actual set of draw- 
ings but rather a structure onto which you can start to build your set of drawings. The Sheet Set Manager 
manages the coordination and continuity of the set as you add sheets to the set. 

To see how these drawing components are managed by the Sheet Set Manager, you’ll create some 
sheets from existing Model Space files. You’ll start by adding a couple of floor plans to the sheet  set. 

You’ll use the resource drawings that you saw in the first set of exercises in this chapter as the basis 
for the new sheets. 

Setting Up Some Views 
The Sheet Set Manager uses drawing views to help simplify the creation of viewports in a sheet, so you’ll 
start by creating some views in a plan drawing. These views will define the areas and layer settings that 
will be needed later when you create the plan sheets. Follow these steps: 

1. Open the plans.dwg file from the \Sheet Set Sample 2\Resource folder. You see two
plans of the house. The top plan is a floor plan, and the lower plan is a combi-nation of a floor
plan and a site plan.

2. Select Plan_site from the Layer State drop-down list in the Home tab’s Layers panel.

You’ve just restored a layer state that shows all the appropriate layers for the site plan. Next you’ll 
save a view of just the site plan, which you’ll use a bit later when you create the site plan sheet: 

1. Type V8  to open the View Manager dialog box.

2. Make sure Current is selected in the list to the left. Then click the New  button.
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3. In the New View/Shot Properties dialog box, enter Site Plan for the view name.

4. In the Boundary group, click the Define Window radio button. The dialog box temporarily closes 
to enable you to select a window to define the view area.

5. Place a selection window around the area shown in Figure bc6.7. Don’t worry if you don’t get it 
right the first time. You can use a selection window repeatedly until you have the view you  want.

6. Press [enter]  when you’re satisfied with the boundary selection.

7. Back in the New View/Shot Properties dialog box, check the Settings group to make sure the Save 
Layer Snapshot With View option is selected and click OK.

8. Click OK in the View Manager dialog box to close it. 

You’ve just created a view for the site plan. Now create another view for the floor  plan: 

1. Go to the Home tab’s Layers panel, and select Plan_finish from the Layer State drop-down list.

2. Choose View Manager from the View tab’s Views panel, or type V8 to open the View Manager
dialog box.

Figure bc6.7 
Selecting the 
view area 

3. Make sure Current is selected in the left panel. Then click New.

Readjusting Your Views 

If you need to adjust the view area, open the View Manager dialog box again, select the view 
name from the list box, and click the Edit Boundaries button. The dialog box closes temporarily, 
and the drawing displays with the view area highlighted. You can then reselect the view area 
with a selection window. 
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4. In the New View/Shot Properties dialog box, enter Floor Plan for the view name. Click the 
Define Window button. Place a selection window around the area shown in Figure bc6.8. Press 
[enter] when you’re satisfied with the area you’ve  selected.

5. Back in the New View/Shot Properties dialog box, click OK. Then click OK in the View Manager 
dialog box to close it.

6. Choose Save from the Application menu to save the changes you’ve just made, and then close  the 
plans.dwg file. 

If you know that you want to use other views for your sheets, you can continue to define more  views. 
But for this exercise, let’s move on to creating a sheet from the views you just created. 

Figure bc6.8 
Selecting the 
view area 

Creating a Sheet 
Now that you have some views defined, you’re ready to create a sheet for those views: 

1. If the Sheet Set Manager isn’t already open, click the Sheet Set Manager tool on the View tab’s
Palettes panel.

2. Select Architectural from the list, right-click, and select New Sheet to open the New Sheet dialog
box.

3. Enter A1 in the Number box. This defines the sheet number that will appear in the lower-right
corner of the sheet. As you type, your entry appears in both the Number box and the File Name
box.

4. Enter Site Plan And Floor Plan in the Sheet Title input box. Again, as you type, your entry
appears in both the Sheet Title box and the File Name box.

5. Click OK. AutoCAD creates a new file called A1 – Site Plan and Floor Plan, and the
new drawing name appears as a subhead below Architectural in the Sheet Set Manager.

6. Double-click the A1 – Site Plan And Floor Plan listing. The sheet appears in  AutoCAD.
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If you look closely, you’ll notice that the sheet number is already in place in the lower-right corner of 
the drawing. The Sheet Set Manager was able to apply the sheet number you entered in step 3 to the new 
sheet because the template uses a field for the sheet-number text. You’ll learn how to add such a field to 
your own title block later in this chapter. For now, you’ll add the views you created in the plans.dwg 
file to this new sheet. 

Adding Your Views to the New Sheet 
You’ve created views in your plans.dwg resource drawing, and you’ve created a new sheet for the plan
views. The next step is to insert those saved views into the sheet. 

Start by adding the resource drawings to the sheet set: 

1. Click the Model Views tab in the Sheet Set Manager, and then double-click Add New Location in
the Location list.

2. Browse to and open the \Sheet Set Sample 2\Resource folder and click Open. The files
in the Resource folder appear in the list of resource drawings.

With the resource files added to the Sheet Set Manager, you can add a view to the A1 sheet from  the 
plans.dwg file you worked on earlier:

1. Click the plus sign next to the plans.dwg item. The list expands to show the Site Plan and Floor
Plan views you created earlier in this chapter.

2. Select Site Plan from the list, right-click, and choose Place On Sheet. Don’t click your mouse yet.
As you move the cursor over the A1 – Site Plan And Floor Plan layout, a rectangle appears at the
cursor and covers most of the drawing.

3. Right-click in the layout view to display a list of drawing scales.

4. Select 1/8" = 1’ from the list. You see the Site Plan view of plans.dwg along with a title bubble,
all following the cursor (see Figure bc6.9). You can also click and drag the Site Plan view from the
list into the sheet to get the same result.
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Figure bc6.9 
Adding and position- 
ing a view 

5. Place the view in the top half of the layout and click. The Site Plan view is placed in the layout
along with a title bubble, drawing scale, and view title.

6. Back in the Sheet Set Manager, select Floor Plan from the list. Right-click and select Place On
Sheet.

7. Right-click in the Layout view, and select 1/4” = 1’ from the list.

8. Place the view in the lower half of the layout and click. The Floor Plan view is placed in the layout
along with a title bubble, drawing scale, and view title.

9. Zoom into the title bubble for the Site Plan view. It already has the proper view name and  scale.

In the preceding exercise, the Sheet Set Manager performed several steps that you could have done
manually with much more effort. It imported the plans.dwg file as an Xref into the A1 – Site Plan And
Floor Plan layout. It then created a viewport in the layout, it scaled the layout view according to your 
selections in steps 4 and 7, and finally, it added a title bubble and the title and scale for each  view. 

Editing the View Numbers 
You need to take care of one more item for this sheet. Although the view names and scales have been 
provided by the Sheet Set Manager, you still need the view numbers. Right now they’re just three dashes. 
Follow these steps: 

1. In the Sheet Set Manager, select the Sheet Views tab.

2. Expand the A1 Site Plan And Floor Plan list, and select Site Plan; then right-click and select
Rename & Renumber to open the Rename & Renumber View dialog box (see Figure  bc6.10). 
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Figure bc6.10 
The Rename & 
Renumber View dia- 
log box 

 
 

 
3. Enter 1 in the Number box. The name of the view is available for editing as well. 

4. Click the Next or Previous button, whichever is available for selection. This advances the data in 
the dialog box to the next view, which is the Floor Plan view. Enter 2 in the Number box. Once 
again, you see the name of the view. 

5. Click OK to close the Rename & Renumber View dialog box. 

6. Type Rem. The title bubbles change to show the numbers 1 and 2 for the two views. 

The final task is to hide the viewport borders. You can do this by creating a layer just for the view- 
ports and then turning off that layer: 

1. Use the Layer Properties Manager to create a layer called Viewport. 

2. Turn off the Viewport layer, and close the Layer Properties Manager. 

3. Select the two viewports. Select Viewport from the Layer drop-down list in the Home tab’s 
Layers panel. The viewports disappear. 

Adding the view numbers is important for two reasons. The obvious one is so that you have a number 
to which you can refer when referencing this plan sheet in the future. But the Sheet Set Manager also 
keeps track of this view number so that later, when you start to add callout blocks to your drawing set, 
the Sheet Set Manager knows which view goes with the callout block you’re adding. The next section  
will show you how this works. 

 
Adding Callout blocks as Cross-Reference Symbols 
As mentioned earlier, in the process of building a set of drawings, you’ll have to add cross-reference 
symbols. One common type of cross-reference indicates an elevation view of a building from a floor 
plan. 

In a typical set of architectural drawings, you’ll have a sheet or several sheets that show the sides of  
a building. The most common views are the north, south, east, and west sides of a building. Elevation 
drawings are used to indicate window locations, wall finishes, building heights, floor levels, and other 
key elements in the design. Reference symbols, called callout blocks in AutoCAD, are placed in the floor 
plan and tell the viewer which sheet contains these elevation drawings and show from where the view is 
taken in relation to the plan. 

In this section, you’ll learn how to set up an elevation view and place callout blocks in the floor plan 
that show which sheet contains the elevation. You’ll see how callout blocks are tied to sheet numbers so 
that even if a sheet number changes, the callout block always indicates the right sheet  number. 

You’ll use a sheet set similar to the one you just started, but with a few additions to save some work  
for you. The My Sheet Set 1.dst sheet set has the A1 Site Plan And Floor Plan sheet already cre- 
ated and an additional sheet called A2 Elevation Plan. This additional sheet contains two elevation  views. 
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They were created in the same way as the plan views in the previous exercise, so no method was used to 
create them that you haven’t already been shown. 

In the following steps, you’ll add a callout block to the A1 sheet that references the A2 sheet. Along 
the way, you’ll become familiar with some of the other features of the Sheet Set Manager. 

Start by closing the current sheet set and the files associated with it: 

1. In the Sheet Set Manager, select the Sheet List tab.

2. Right-click My Sheet Set in the list, and choose Close Sheet Set.

3. Close and save any drawing that may be open except the blank default drawing file.

Next, open the sample sheet set:

1. Click Open from the Sheet Set Manager drop-down list. Then, in the Open Sheet Set dialog
box, locate and select My Sheet Set 1.dst in the Chapter BC6\Sheet Set Sample 3
folder. Click Open in the Open Sheet Set dialog box.

2. Make sure the Sheet List tab is selected, and then double-click A1-Site Plan And Floor Plan and
A2 Elevations to open these two files.

Next you’ll add the callout symbol to the A1 sheet. In the next few steps, you will be adding callout 
symbols based on preexisting views from the A2 Elevations  drawing: 

1. In the Sheet List tab of the Sheet Set Manager, double-click the A1 sheet again. Because it’s 
already open, double-clicking the A1 sheet makes it the current drawing  file.

2. Enlarge your view of the floor plan so it looks similar to Figure bc6.11. 

3. Click the Sheet Views tab in the Sheet Set Manager; then select and right-click 1 – South 
Elevation.

4. Choose Place Callout Block > Elev Indicator Ext – Up from the context menu. As you move the 
cursor into the drawing area, a symbol appears at the cursor. This is the callout block for the exte-
rior elevation.

5. Position the callout block as shown in Figure bc6.11 for the south elevation and click. The callout 
block already shows the appropriate drawing number and sheet  number.

6. Right-click 2 – West Elevation, and choose Place Callout Block > Elev Indicator Ext – Right 
from the context menu.

7. Place this callout block to the left of the floor plan, as shown in Figure bc6.11.  

Adjusting Xref Fade 

You may notice that the plans in your view appear faded. That’s because the plans are actually 
Xrefs, which by default are set to a 70% fade. You can adjust the amount of fade using the Xref 
Fading slider in the Insert tab’s expanded Reference panel. Set the Xref Fading slider to 0 to 
remove the fade effect altogether. 
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Figure bc6.11 
Enlarge your view, 
and place the callout 
blocks as shown. 

When you inserted the callout blocks in steps 4 through 7, the Sheet Set Manager automatically added 
the appropriate sheet and view number to the block. This action saves you the effort of checking which 
drawing contains the elevation view and of making sure the numbers between the callout block and view 
match. 

Editing Sheet Numbers and Title block information 
Suppose you need to change the sheet number of the elevation sheet from A2 to A3 to make room for a 
demolition plan. The following exercise demonstrates how the Sheet Set Manager can make quick work 
of such a change: 

1. In the Sheet Set Manager, select the Sheet List tab.

2. Right-click the A2 Elevations sheet item, and choose Rename & Renumber.

3. In the Rename & Renumber Sheet dialog box, change the number from A2 to A3 and click  OK.

4. Type Re[enter]. The elevation callout blocks you just added now show the new sheet number 
for the elevation sheet. 

Adding Hyperlinks 

Later, when you learn how to create your own custom callout blocks, you’ll learn about the hyper- 
link feature. The callout blocks you just added have this feature turned on. If you Ctrl+click the 
text of either of the callout blocks, AutoCAD will open the drawing containing the view that the 
callout block references------namely, the A2 Elevations  drawing. 

Place 2—West Elevation 
Callout Block here. 

Place 1—South Elevation Callout Block here. 
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5. Double-click A3 Elevations from the Sheet List tab, and type Re[enter] . The sheet number in the
lower-right corner of the drawing changes to A3.

As you saw from this exercise, the drawing numbers are coordinated through settings in the Sheet Set 
Manager as long as you use the callout symbols from the Sheet Set  Manager. 

Drawing numbers aren’t the only part that can be managed through the Sheet Set Manager. You have 
two sheets in the set now, but they were created without regard for the client name and address in the title 
block. You’ll need to go back and add this information to the sheets. Here’s a quick way to do  it: 

1. In the Sheet List tab of the Sheet Set Manager, right-click My Sheet Set 1 at the top of the list box
and then choose Properties to open the Sheet Set Properties dialog box (see Figure bc6.12).

2. Use the scroll bar to the left to scroll down to the lower half of the Sheet Set Properties dialog box
where you see a set of options labeled Sheet Set Custom Properties. Click the Project  Address 1
label, and enter 444 Ramona Way for the first line of the address. (Or you can add any street
address you like.) You may need to widen the first column to read the label or hover over the label
to see a tool tip showing the full label.

3. In the next option, Project Address 2, enter Big Bear, CA.

4. Enter Smith Residence for the project name.

5. Leave the Client, Project Number, and Project Address 3 options set to Value. Click OK.

6. Zoom into the lower-right corner of the sheet so that you can clearly see the title-block informa-
tion, and then type Re[enter]  to display the changes in the current sheet.

The changes you made in this exercise affect all the existing sheets in the set. If you add new sheets, 
they will also display the new address and project  name. 

Figure bc6.12 
Sheet Set Properties 



Bonus Chapter for Mastering AutoCAD 2017 and AutoCAD LT 2017 

22   | 

Closing a Sheet Set 
By now, you have two sheet sets open: the one you created from an existing set of drawings and the one 
you opened for the latest set of exercises. In the next sections, you’ll look at customizing sheet sets. You 
won’t need both sheet sets open. Close the one on which you’ve been working by following these  steps: 

1. Click the drop-down list at the top of the Sheet Set Manager.

2. Right-click My Sheet Set 1, and select Close Sheet Set.

As you can see, you can have multiple sheet sets open at any one time. This feature can facilitate the 
movement of drawing data from one project to another. For example, you may want to borrow construc- 
tion details from one set to add to a new set. You can use the Sheet Set Manager to locate the detail sheet 
from the prior project and then cut and paste drawing data from that drawing into a drawing in your most 
current project. 

Customizing Sheet Sets 
In the preceding sections, you created and used a sheet set that was based on a canned sheet set from 
Autodesk. That sheet set included a title block with many of the field text objects already embedded so  
that you could take advantage of the Sheet Set Manager’s ability to control the text in the title block. The 
view title bubbles and callout blocks were also supplied, and they contained the field text objects to auto- 
mate the insertion of view names and coordination of callout cross-reference  numbers. 

But not everyone will want to use the title blocks and symbols offered in the Autodesk samples. You 
aren’t limited to using the canned sheet set from Autodesk. In the following sections, you’ll look at how 
to customize your own title block to work with the Sheet Set Manager. You’ll also learn how to create 
custom view titles and callout blocks. 

Customizing a Title block 
To begin your exploration of sheet set customization, you’ll add field objects to the sample title block you 
used at the beginning of this chapter. Remember that the first project included an existing set of draw- 
ings that wasn’t set up to take full advantage of all the sheet set features you saw in the latest set of exer- 
cises. The title block in that early exercise contained some attributes that could be used to include text 
information, but the title block was not sheet set aware. To prepare a title block for use with the  Sheet 
Set Manager, you’ll need to convert those attribute values into field objects. This entails editing the title 
block and saving it as the template file for the sheet set. 

Close All of the Files 

In preparation for the next sections, close all the drawings that are open in AutoCAD. Closing a 
sheet set doesn’t automatically close the drawings associated with  it. 



Bonus Chapter for Mastering AutoCAD 2017 and AutoCAD LT 2017 

|  23 

Setting Up Sheet Numbers and Titles 
The first thing you’ll do is set up the title block to create a sheet set–aware number and title. Doing so 
will enable the Sheet Set Manager to control the number and title that appears in the title block, as you 
saw in earlier exercises. 

You could open the template file and start editing the title block without involving the Sheet Set 
Manager in any way. But now, in the following set of exercises, you’ll edit the template file with a little 
help from the Sheet Set Manager. By using the Sheet Set Manager while editing your template file, you’ll 
be able to get instant feedback on your edits. 

Start by creating a new sheet in the sheet set you created at the beginning of this chapter. You’ll use 
this new sheet to edit the title block. Follow these steps: 

1. Start a new, blank drawing, and then, if the Sheet Set Manager is closed, open it by clicking the
Sheet Set Manager tool in the View tab’s Palettes panel.

2. Open the sheet set named My Existing Sheet Set. Remember that this was the first sheet set

in the 6-Keeping a Project Organized with Sheet Sets\Sheet Set Sample
1 folder. You can open it by selecting Open > Recent > project file location\6-
Keeping a Project Organized with Sheet Sets\Sheet Set Sample 1\My
Sheet Set.dst from the Sheet Set Manager where project file location is the 
location for your Mastering AutoCAD sample files.

3. In the Sheet List tab, right-click the sheet set name at the top of the list and choose New Sheet.

4. In the New Sheet dialog box, enter 000 for the sheet number and Template Edit for the sheet title.
Click OK. The sheet number and title can be anything because this isn’t a sheet you’ll save.

5. In the Sheet Set Manager, double-click 000 – Template Edit. The sheet you just created appears in
the AutoCAD window.

Remember that a new file based on a template is really just a copy of the template. As we mentioned 
earlier, the title block is an AutoCAD block that contains attribute definitions. To edit those definitions, 
you’ll need to explode the block: 

1. Click the title block to select it.

2. Click the Explode tool in the Home tab’s Modify panel.

Now you’re ready to edit the attribute definitions. Start by editing the definition for the sheet number
in the lower-right corner of the title block: 

Defining Title blocks 

In the following sections, we use the terms title block and AutoCAD block, which may cause confu- 
sion. Title block is a standard drafting term meaning the drawing border and drawing title infor- 
mation, including a business logo and other textual information about the drawing. AutoCAD 
block refers to the type of AutoCAD object known as a block that is a collection of objects com- 
bined into one object. See Chapter 4, ‘‘Organizing Objects with Blocks and Groups,’’ for more on 
AutoCAD blocks. 
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1. Locate the attribute definition that is in the lower-right corner of the title block and shows a large
NO. and double-click it. This is the attribute definition for the sheet number. The Edit Attribute
Definition dialog box opens (see Figure bc6.13).

2. Double-click in the Default text box. Right-click it, and choose Insert Field to open the Field dia-
log box (see Figure bc6.13).

3. Select SheetSet from the Field Category drop-down list.

4. In the Field Names list box, select CurrentSheetNumber.

5. In the Format list box, select Uppercase. Then click OK.

6. Back in the Edit Attribute Definition dialog box, the Default text box now shows 000—the
number you assigned to this drawing. This tells you that your field attribute is working properly
because the default value shows the current sheet number. The gray background of the text tells you
that the text is a field.

7. Click OK to exit the Edit Attribute Definition dialog box.

8. Press [enter]  to exit attribute-editing mode.

In step 6, you received instant feedback when you assigned the CurrentSheetNumber attribute field

to the attribute definition. The default value changed to the sheet number of the current  drawing.
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Figure bc6.13 
Inserting a field in 
the attributes 

Next you’ll make a similar change to add the project name to the title block: 

1. Zoom into the area of the title block that shows the project information (see Figure  bc6.14).

2. Double-click the DRAWING_TITLE attribute definition just below the OWNER3 attribute
definition.

3. As in the preceding exercise, select the Default value, right-click, and choose Insert Field.

4. Select CurrentSheetTitle from the Field Names list, and select Title Case from the Format
list.

5. Click OK. Now the Default value is the current sheet title, Template  Edit.

6. Click OK to accept the changes in the Edit Attribute Definition dialog  box.

7. Press [enter]  to exit attribute-editing mode.

These two exercises demonstrated how you can add a field object to an attribute definition and have

that definition give you immediate feedback about its association to the sheet set. In the first case, the 
default sheet number in the Edit Attribute Definition dialog box reflected the current sheet number. In 
the second exercise, you saw that the sheet title appeared. 
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Figure bc6.14 
Zoom into the 
project info. 

Adding Custom Sheet Set Properties 
You’ve added two of the standard sheet set fields to the title block. The standard fields are the ones that 
appear in the Field Names list in the Field dialog box. But what if you want to add custom sheet set fields that 
aren’t on the list? You can create your own field categories in the Sheet Set Manager. In the following set of 
exercises, you’ll create some custom fields in the Sheet Set Manager properties dialog box and then add 
those fields to your title block. 

First, set up some new custom fields: 

1. In the Sheet Set Manager, right-click My Existing Sheet Set at the top of the sheet list and choose
Properties.

2. At the bottom of the Sheet Set Properties dialog box, click the Edit Custom Properties button to
open the Custom Properties dialog box.

3. Click the Add button to open the Add Custom Property dialog box.

4. In the Name text box, enter Project 1. This will be the first line for the project information area in
the title block.

5. In the Default Value text box, enter Project Line 1.



Bonus Chapter for Mastering AutoCAD 2017 and AutoCAD LT 2017 

|  27 

6. In the Owner group at the bottom of the dialog box, make sure Sheet Set is selected. This tells the
Sheet Set Manager that this value applies to all the sheets in the set, not just individual  sheets.

7. Click OK to return to the Custom Properties dialog box.

8. Repeat steps 3 through 7 to add two more custom properties called Project 2 and Project 3, with
the values Project Line 2 and Project Line 3.

9. Click OK to close the Custom Properties dialog box, and then click OK in the Sheet Set
Properties dialog box.

You’ve created some custom properties. Now include those properties in your title  block: 

1. Pan up to the area in the title block that shows the project  information.

2. Double-click the Project 1 attribute definition. In the Edit Attribute Definition dialog box, high-
light the Default text box, right-click, and choose Insert Field.

3. In the Field Names list box (see Figure bc6.15), select  CurrentSheetSetCustom.

4. Open the Custom Property Name drop-down list near the bottom of the dialog box, and select
Project 1. All the custom properties you created are listed here, as you can see in Figure  bc6.15. 

Figure bc6.15 
Choose from the list 
of field names. 

5. Click OK to return to the Edit Attribute Definition dialog box. The default field value shows
Project Line 1, which is the default value you gave for the custom properties in the previous
exercise.

6. Click OK, and then repeat steps 2 through 5 for the Project 2 and Project 3 attribute  definitions.
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7. Press m to exit attribute-editing mode.

Saving Your New Title block as a Template 
You’ve just seen how to include custom sheet set properties in your title block. Now you’re ready to con- 
vert your newly edited title block back into the template file you’re using for this sheet  set. 

First you need to turn your exploded title block back into an AutoCAD block object: 

1. Zoom out so that you can see all of the title block.

2. Click the Create tool on the Home tab’s Block panel.

3. In the Block Definition dialog box, select 22x17ArchBlock from the Name drop-down list.

4. In the Objects group, click the Select Objects button and select the entire title block.

5. Make sure the Convert To Block radio button is selected in the Objects  group.

6. Click OK. A warning message tells you that you’re about to redefine the 22x17ArchBlock block.
Click Redefine.

7. The Edit Attributes dialog box opens. You don’t need to change anything here, so
click OK.

The title block now shows the sheet number 000. If you look closely, you’ll also see that the sheet title 
shows Template Edit. These are the name and number you assigned to this sheet when you first created it. 

The next task is to save the file as the template file for the current sheet set: 

1. Right-click in the Layout tab labeled 000 Template Edit, and choose Rename.

2. Rename the layout My Title Block.

3. Choose Save As from the Application menu. In the Save Drawing As dialog box, select AutoCAD
Drawing Template (*.dwt) from the File Of Type drop-down list.

Browse to the location of the template file for this sheet set, select 22x17 Arch.dwt, and click Save.
This location is \Sheet Set Sample 1\Resource. Click Yes in the warning message box.

4. Click OK in the Template Options dialog box.

Normally, at this point you could close the newly saved template file and remove the 000 – Template

Edit sheet from the sheet list. However, you’ll use this file again when you create other components of 
the sheet set. 

Testing the New Template 
Now you can test the new template to make sure it’s working. You’ll start by creating a new sheet to 
check whether the sheet number and title appear  correctly: 

1. Right-click My Existing Sheet Set, and choose New Sheet.

2. Enter A5 for the number and Schedules for the title, and then click  OK.
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3. Double-click A5 – Schedules from the sheet list of the Sheet Set Manager to open it. The sheet
shows A5 for the number and Schedules for the title.

Taking Advantage of Other Field Options 

As you learned in Chapter 11, you can add field objects directly to a drawing if you want drawing 
data to appear as text. For example, you can add field text directly in a drawing layout to provide 
information about the author of a drawing, the date the drawing was printed, or the scale to 
which the layout is set to plot. 

This information can be included in small print on the border of the drawing to aid others when 
they need to know more about the drawing’s origin. You can either add the field directly to the 
drawing by using the Field command or include it in Mtext or Dtext as part of a paragraph or 
sentence. Here is a list of field options from the Field Category list in the Field dialog box to help 
you get an idea of what you can include as text in a sheet: 

Date & Time Lets you add a date and time stamp to your drawing. You can select from a 
variety of date and time styles or show only a date or only a  time. 

Document  Lets you add data from the drawing properties that are stored in AutoCAD  
by using the Dwgprops command (choose Drawing Utilities a Drawing Properties from the 
Application menu). This includes information such as the author, filename, file size, com- 
ments, title, and subject. 

Linked    Lets you add a hyperlink to another file. 

Objects Lets you include the name or property of an object. For example, you can add a 
block name as a field text label, or you can add an object’s layer. 

Other     Lets you add Diesel expressions or system-variable values as field text. 

Plot Lets you display plot settings as text in your drawing. This can be useful to help others 
determine how a drawing was plotted. 

SheetSet Offers options to help automate many of the labeling chores you normally do 
when creating sheets. 

You also added some custom sheet set properties. Do the following to see if they’re working  properly: 

1. Right-click My Existing Sheet Set at the top of the sheet list in the Sheet Set Manager and choose
Properties.

2. Toward the bottom of the Sheet Set Properties dialog box, change the value for Project 1 to John
Smith Residence.

3. Change the value for Project 2 to 123 Anystreet. Change the value for Project 3 to Roseville,
California.

4. Click OK.

5. Type Re[enter] . The title block now shows the new project information you just edited.
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You’ve customized the title block with custom properties and a sheet set–aware number and title. 
Armed with this information, you can customize any title block to take full advantage of the sheet set 
features. 

You can include a lot of information in the title block through the Sheet Set field option. Table BC6.1 
gives you a rundown of the sheet set options to help you decide what you may want to include. 

Table  bc6.1: Field options available for sheet sets 

Field name Purpose 

CurrentSheetCustom Displays custom sheet data. Custom sheet data can be added and edited 
through the Sheet Set Properties dialog box. 

CurrentSheetDescription Displays the description for the current sheet found in the properties for 
the sheet. Select the sheet name from the Sheet Set Manager’s Sheet List 
tab, right-click, and choose Properties. 

CurrentSheetNumber Displays the current sheet number. 

CurrentSheetNumberAndTitle Displays the sheet number and title combined into one line of text. 

CurrentSheetSet Displays the name of the current sheet set. 

CurrentSheetSetCustom Displays a custom value for the current sheet set. 

CurrentSheetSetDescription Displays the sheet set description, which can be found in the Sheet Set 
Properties dialog box. 

CurrentSheetSetSubSet Displays the name of a subset of the current sheet set. 

CurrentSheetTitle Displays the current sheet title. 

SheetSet Displays any standard sheet set value, such as sheet number and 
title, sheet title, sheet number, or sheet description, from any sheet in 
the sheet set. 

SheetSetPlaceholder Displays standard sheet set values from within callout blocks. 

SheetView Displays sheet set view data, such as view title, view number, and view 
scale. 

CurrentSheetCategory Displays a category field. 

CurrentSheetIssuePurpose Displays an Issue Purpose field. 

CurrentSheetRevisionDate Displays a Revision Date field. 

CurrentSheetRevisionNumber Displays a Revision Number field. 

CurrentSheetProjectMilestone Displays a Project Milestone field. 

CurrentSheetProjectName Displays a Project Name field. 

CurrentSheetProjectNumber Displays a Project Number field. 

CurrentSheetProjectPhase Displays a Project Phase field. 
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Table bc6.1: 

Creating Custom View Labels and Callout blocks 
In the section “Managing Title Blocks and Cross-References” earlier in this chapter, you learned how  
to create a new sheet set from an existing one. You saw that the Sheet Set Manager was able to create  a 
viewport and add a view label automatically, including a view number bubble, a view title, and the scale 
for the view. Just like the title block, the view label you used in the section “Adding Your Views to the 
New Sheet” was a block with field attribute values. You can create your own view label block or edit an 
existing one by using the methods you’ve already seen for the title block. Callout blocks are also created 
and edited in the same way. 

Creating the Components of Your View Label 
In this section, you’ll create a custom view label. This will help you to understand which field attributes 
are used for the view label. You’ll also learn how to set up the Sheet Set Manager to use your custom 
block. 

Just as with the title block, you could create the view label block in AutoCAD without using the Sheet 
Set Manager, but using the Sheet Set Manager simplifies your work and also helps verify that you’re on  
the right track. You’ll start by going back to the template file you edited earlier, and then you’ll create the 
graphics and attribute definitions for your custom view label. Follow these  steps: 

1. Close the A5 Schedules.dwg file, and return to the 22x17 Arch.dwt file that you updated
in the earlier exercise. You can use the Application menu to return to the file. You’ll add the view
label block to this drawing.

2. Make sure the current layer is set to 0; then draw a circle with a 0.25" diameter.

3. Add a line to the right of the circle that is 1" long, as shown in Figure  bc6.16. 

Figure bc6.16 
Beginning to create 
the view label block 

4. Click the Define Attributes tool in the Home tab’s expanded Block panel to open the Attribute
Definition dialog box (see Figure bc6.17). 

5. Enter ViewNumber in the Tag text box and View Number in the Prompt text box.

0.25˝-diameter circle 1˝ line 
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Figure bc6.17 
Defining an attribute 

6. Click the Insert Field button to the right of the Default text box to open the Field dialog box.

7. Select SheetSet in the Field Category drop-down list, and then select SheetSetPlaceholder from
the Field Names list.

8. Select ViewNumber from the Placeholder Type list and Uppercase from the Format list (see
Figure bc6.18). 

You’ve just added the field that this block will need for the view number. Next you need to make
sure the text is formatted correctly.

9. Click OK to return to the Attribute Definition dialog box. Set the Justification value in the Text
Settings group to Middle, and set the Text Height value to 0.15.
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Figure bc6.18 
Defining the field 
to insert 

10. Turn on the Preset option in the Mode group. If you don’t turn on the Preset option, you’ll be
prompted for the attribute value when the view is inserted even though the Sheet Set Manager
supplies these values automatically.

11. Click OK. Then use the Center osnap to place the attribute definition in the center of the  circle.
VIEWNUMBER appears in large letters, centered on the  circle.

If you forgot a setting in the previous steps, you can always go back and use the Properties palette to 
modify the attribute definition settings. Select the attribute definition, right-click, and choose   Properties. 

Next you need to add the view title and scale. The steps to add these parts of the view label are the 
same as for the view number you just added. You first create an attribute definition by using the Insert 
Field option for the attribute value. The only difference is the location and text options for the attribute 
definition. Here are the steps: 

1. Click the Define Attributes tool in the Home tab’s expanded Block panel to open the Attribute
Definition dialog box again. Enter ViewTitle in the Tag text box and View Title in the Prompt
text box.

2. Click the Insert Field button to the right of the Default text box to open the Field dialog box.
Select SheetSet in the Field Category drop-down list, and select SheetSetPlaceholder from the
Field Names list. 

3. Select ViewTitle from the Placeholder Type list and Title Case from the Format  list.

4. Click OK. Then, in the Attribute Definition dialog box, set Justification to Left and Text Height
to 0.15. Also make sure the Preset option in the Mode group is  selected.
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5. Click OK, and place the attribute definition approximately as shown in Figure  bc6.19. 

Figure bc6.19 
The parts of the view 
label block 

Finally, you need to add the scale information to the view title: 

1. Click the Define Attributes tool in the Home tab’s expanded Block panel to open the Attribute
Definition dialog box a third time. Enter ViewScale in the Tag text box and View Scale in the
Prompt text box.

2. Click the Insert Field button to open the Field dialog box. Make sure SheetSet is selected in the
Field Category drop-down list and SheetSetPlaceholder is selected in the Field Names list.

3. Select ViewportScale from the Placeholder Type list, and select #" = 1'-0" from the Format  list.

4. Click OK to exit the Field dialog box.

5. Set the Justification value in the Text Settings group to Left, set the Text Height value to 0.1, and
select the Preset option.

6. Click OK. Then place the View Scale attribute definition approximately as shown in Figure
bc6.19. 

Turning the Components into a block 
You have all the attribute definitions you’ll need. The next task is to turn the whole thing into a block: 

1. Choose Create from the Home tab’s Block panel.

2. In the Block Definition dialog box, enter ViewTitle for the block name.

3. Click the Select Objects button. Select all the objects you created in this set of exercises,
includ-ing the circle and line you started with. Press [enter]  when you’ve made your selection.

Basepoint View title attribute definition 

View scale attribute definition 
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4. Click the Pick Point button in the Base Point group, and select the point indicated in Figure bc6.19. 
This is important because the insertion point of the block will coincide with the lower-left corner
of the viewport that the Sheet Set Manager creates when adding views to a sheet.

5. Click OK to finish the block. The block is now a part of your template file. All you need to do is
save it to have the block available to the Sheet Set Manager.

6. If the ViewTitle block remains in the drawing, erase it. Then zoom out so that you see the entire
layout.

7. Click Save on the Quick Access toolbar to save the template file, which now includes your
ViewTitle block.

You may notice that, in step 5, the text in the block obscured the circle and line graphic. Fields always 
show a gray background to distinguish them from other types of text. The gray background doesn’t print, 
so even though it appears to cover the line and circle, the fields won’t interfere with the printing of those 
objects. 

including Your View Label in the Sheet Set 
You must complete one more task to let the Sheet Set Manager know that your ViewTitle block is 
available. To do this, you need to open the Sheet Set Manager Preferences dialog box and point to the 
ViewTitle block. Here’s how that’s done: 

1. Right-click My Existing Sheet Set in the sheet list and choose  Properties.

2. In the Sheet Set Properties dialog box, click Label Block For Views in the Sheet Set section (see
Figure bc6.20).

Figure bc6.20 
Choose to label the 
block. 

3. Click the Browse button to the far right of Label Block For Views.

4. In the Select Block dialog box, click the Browse button to the far right of the Enter The Drawing
File Name text box.
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5. Choose AutoCAD Drawing Template (*.dwt) in the Files Of Type drop-down list at the bottom of
the Select Drawing dialog box. Then locate and select the 22x17 Arch.dwt template file with
which you’ve been working for this sheet set.

6. Back in the Select Block dialog box (see Figure bc6.21), click the Choose Blocks In The
Drawing File radio button. Select ViewTitle from the list box just below the option. Click OK
after you’ve made the selection, and then click OK in the Sheet Set Properties dialog  box.

Remember that you created the ViewTitle block inside the 22x17 Arch.dwt template file, so when
you saved that file, the block became a part of that template file. In steps 4 and 5, you selected the tem- 
plate file and then selected the block in that file. If you prefer, you can save your view title blocks as indi- 
vidual files. If you choose this route, make sure that you select the Select The Drawing File As A Block 
option in step 4. 

Figure bc6.21 
Set the Select Block 
options. 

Now you’re ready to test the block by adding a sheet and inserting a view. Remember that the Sheet 
Set Manager uses views to determine the contents of new viewports. Follow these  steps: 

1. Right-click My Existing Sheet Set in the sheet list, and choose New  Sheet.

2. Enter 001 for the number and View Test for the sheet title, and click OK.

3. Double-click 001 View Test in the sheet list to open the file.

4. Click the Model Views tab of the Sheet Set Manager.

5. Under the Projects\Chapter 28\Sheet Set Sample 1\Resources category, expand the elevations.dwg
listing.

6. Right-click South Elevation in the list, and choose Place On  Sheet.

7. Right-click the layout drawing area, and choose 1/8” = 1’-0”. Click in the layout to place the view.
The view appears along with the ViewTitle block that you created in the beginning of this  section.

You’ve seen how to create a custom view label block. The process for creating a callout block is basi- 
cally the same. 
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Creating a Callout block 
You may recall that you were able to insert a callout block in a Plan view that was linked to an elevation 
drawing on another sheet. You can create a custom callout block by using the same steps you used to cre- 
ate the view title block in the preceding section. The only difference is that you select a different set of 
field values for the block’s attribute definitions. 

A callout block typically shows a circle with a view number on top and a sheet number on the bottom, 
as shown in Figure bc6.22. 

Figure bc6.22 
A typical callout 
block inserted in a 
drawing 

Figure bc6.23 shows an exploded version of the callout block with the attribute definitions labeled   
with the appropriate field values. Those field values are found under the SheetSetPlaceholder field names 
in the Field dialog box. 

Figure bc6.23 
The attribute defini- 
tions of a callout 
block and their asso- 
ciated field values 

SheetNumber field 

In addition, you’ll want to select the Associate Hyperlink option in the Field dialog box (see Figure 
bc6.24). 



Bonus Chapter for Mastering AutoCAD 2017 and AutoCAD LT 2017 

38   | 

Figure bc6.24 
Choose to create a 
hyperlink. 

With this option selected, a hyperlink is created between the callout block and the view associated 
with it. This hyperlink will enable you to go directly to the sheet and the view being referenced by the 
callout block by Ctrl+clicking the field value in the callout block. 

Just as with the view title block, you can include the callout block inside the template file, or you can 
create individual files for each of your callout blocks. You can also have several callout blocks for differ- 
ent purposes. 

For example, in the My Sample Sheet Set you created toward the beginning of this chapter, several 
callout blocks were available in the View List context menu (see Figure bc6.25). 

Figure bc6.25 
Choose a callout 
block. 

In that example, there was a callout block for the arrow directions. You can create a similar set of call- 
out blocks for your drawings. You can also include callout blocks for details and finishes. You can even 
invent some uses on your own. 



Bonus Chapter for Mastering AutoCAD 2017 and AutoCAD LT 2017 

|  39 

Reviewing the Steps for Creating Custom Callout and View Label 
blocks 
The callout block and view label feature will save you a lot of time when you’re building your set of 
drawings, but you must go through a lot of steps when creating them. To help you get a better overall 
grasp of the process, here is a checklist of the general steps you need to  take: 

• Create the graphics for the callout blocks.

• Create the attribute definitions for the text in the callout blocks.

• Assign the appropriate fields for the attribute definition values. For callout blocks and view titles, 
this is usually a SheetSetPlaceholder field.

• Convert the graphics and attribute definitions into a block. Place the insertion point of view title 
blocks in the upper-left corner of the block to coincide with the location of the lower-left corner of 
the viewport with which it will be associated.

• Use the Sheet Set Properties dialog box to indicate the file location of your callout and view title 
blocks. These can be blocks in a file or individual files. 

Also remember to turn on the Associate Hyperlink option when selecting the fields for your callout 
blocks. 

Archiving, Publishing, and eTransmitting Sheet Sets 
The sheet set feature is a great way to keep your project files organized while you’re creating your draw- 
ings. You can also use the Sheet Set Manager to turn your set into a package that can be easily sent to 
others who may need to work on the drawings or view them. And you can use the Sheet Set Manager to 
create an archive of your set for safekeeping at the end of the project. 

You may have noticed that the Sheet Set context menu contains several options. Right-click the main 
title of your sheet set in the Sheet Set Manager’s sheet list and you see the Archive, Publish, and eTrans- 
mit options: 

• The Archive option lets you collect your sheet set files into a Zip archive file.

• The Publish option offers a convenient way to convert your set into a format that can be easily read 
by others who don’t have AutoCAD.

• The eTransmit option offers a way to transport your sheet set easily to others who may need to work 
on the set. 

Use the AutoCAD Callout blocks 

If you like the callout blocks and label blocks that are already available in the My Sample Sheet 
Set exercise, you can find them as blocks in the template file used for that project. The location 
of that template file is C:\Users\User Name\AppData\Local\Autodesk\AutoCAD 
2017\R21.0\enu\Template\SheetSets\Architectural Imperial.dwt. You can 
customize the graphics for that template file and use them for your own  projects. 
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In the following sections, you’ll take a closer look at these three sets of features for sharing your sheet 
set. 

Archiving Your Sheet Set 
One of the most important housekeeping jobs you’ll do is archiving completed projects. If you organize 
your projects by folders, you could archive the entire folder for a project, but in so doing, you might 
archive many files that weren’t part of the set. 

The sheet set Archive option lets you be more selective about the files you archive. You can exclude 
files in the sheet set or include other files that aren’t necessarily AutoCAD  drawings. 

When you’re ready to archive your sheet set, save all the files in your archive and then open the 
Archive dialog box. To do this, right-click the name of your sheet set in the Sheet List tab of the Sheet  
Set Manager and choose Archive from the context menu to open the Archive A Sheet Set dialog box (see 
Figure bc6.26). 

The Archive A Sheet Set dialog box has three tabs. On the Sheets tab, the check boxes by the sheet 
names indicate the sheets that will be archived. If you decide that you want to leave a sheet out of the 
archive, you can remove the check mark. The unchecked file and its associated Xref aren’t  archived. 

The Files Tree tab offers a slightly different view of the archive. Instead of just showing you the sheet 
names, the Files Tree tab shows you the names of the files that will be archived. These include support 
files such as the sheet set data file and the template file associated with the sheet  set. 

The Files Table tab shows you even more detail about the files that will be archived, such as the path, 
the AutoCAD version, and similar information. It also includes information about the resource files that 
are Xrefs in the sheet files. 

In both the Files Tree and Files Table tabs, the Add A File button enables you to include other files 
with the archive that aren’t necessarily AutoCAD related but are part of the overall project. You can use 
this option to include Excel or Word documents that represent correspondence or  worksheets. 

Figure bc6.26 
Archiving a sheet set 
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Modifying the Archive Setup 
By default, the sheet set Archive feature saves files in the Zip archive format (.zip filename extension).
You can change the way the archives are saved as well as the location of the archive, the archive name, 
and several other settings through the Modify Archive Setup dialog box. 

Click the Modify Archive Setup button in the Archive A Sheet Set dialog box to open the Modify 
Archive Setup dialog box (see Figure bc6.27). 

Figure bc6.27 
Editing the archive 
setup 

Here you can make adjustments to the properties of the archive file, including the type of file to cre- 
ate and whether to preserve the file structure. 

Saving the Vital Statistics of Your Archive 
You can also view and save pertinent information about your archived sheet set by clicking the View 
Report button in the Archive A Sheet Set dialog box. Clicking this button opens the View Archive 
Report dialog box. 

You can view the vital statistics regarding your sheet set archive. You also have the option to save the 
information in a file by clicking the Save As button. This opens a standard save file dialog box where 
you can assign a name and location for the information file. It’s stored as a plain-text file with the .txt 
filename extension. 

batch-Plotting and Publishing Your Sheet Set 
Another advantage of using sheet sets is that you can print all the sheets in a set at once and in the back- 
ground. The Publish option in the Sheet Set context menu enables you to turn the Sheet Set Manager into  
a batch-plot utility. 
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When you right-click the sheet set title in the sheet list of the Sheet Set Manager, you see the Publish 
option. Click Publish and another set of options appears (see Figure bc6.28), offering several plotting and 
publishing options. 

Figure bc6.28 
Options for 
publishing 

The following list gives a rundown of these options. More detailed descriptions are offered in Chapter 
8, “Introducing Printing, Plotting, and Layouts,” and Chapter 25, “Managing and Sharing Your Drawings.” 
See Bonus Chapter 3, “Hardware and Software Tips,” for more on plot stamps. 

Publish To DWF Publishes your sheet set to a DWF file. This option uses the Publish command’s 
current default settings and the Sheet Set Publish Options. Before you use this option, make sure your 
settings are correct by using the Sheet Set Publish Options command in the Sheet Set context  menu. 

Publish To DWFx Publishes your sheet set to a DWFx file. This file format is similar to the DWF 
format with the added ability that it can be viewed in Windows 7 and later without any special view- 
ing program. 

Publish To PDF Publishes your sheet set to a PDF file. This file format is so prevalent in the busi- 
ness world that it’s often the format of choice when exchanging CAD  drawings. 

Publish To Plotter Sends your sheet set to a printer or plotter. This option uses the Publish com- 
mand’s current default settings and the Sheet Set Publish Options. Before you use this option, make 
sure your settings are correct by choosing Publish a Sheet Set & Publish Options in this context 
menu. 

Publish Using Page Setup Override Enables you to override the default layout settings in your 
sheets with a named page setup. See Chapter 8 for more on page setups. This can help unify the plot- 
ter settings for all the sheets in your sheet set. 

Edit Subset And Sheet Publish Settings Enables you to select specific sheets to be published from  
the sheet set. Use this feature if you want to publish only a subset of the entire sheet  set. 
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Publish In Reverse Order Sends the drawing sheets to the printer or plotter starting with the last 
sheet and adding subsequent sheets from back to front. 

Include Plot Stamp Turns on the plot stamp feature in AutoCAD. A check mark appears next to 
this option when it is turned on. See Bonus Chapter 3 for more on plot stamps. 

Plot Stamp Settings Opens the Plot Stamp dialog box. You can then make setting changes to your 
plot stamps. See Bonus Chapter 3 for more on plot stamps. 

Manage Page Setups Lets you edit or create a page setup that you want to apply to your sheets as 
they’re published. When you click this option, the Page Setup Manager dialog box opens, which is the 
same dialog box you see when you right-click a layout preview panel and choose Page Setup Manager. 
See Chapter 8 for more on page setups. 

Sheet Set DWF/PDF Publish Options Opens the Sheet Set Publish Options dialog box, which is 
essentially the same as the Publish Options dialog box described in Chapter 25. This dialog box lets 
you set the type of DWF or PDF file to create, the file location, and security options. 

Publish Dialog Box Opens the Publish dialog box and populates the Sheets To Publish list with the 
sheets in the sheet set. See Chapter 27 for more on the Publish dialog box. 

Packaging Sheet Sets with eTransmit 
In Chapter 27, you learned that you can use the eTransmit feature to package a set of AutoCAD files into  
a Zip file in order to send the files to someone else who may need to edit them. eTransmit is similar to the 
sheet set Archive feature, but it also makes sure that all the supporting files, including fonts, font maps, 
and plotter configuration files, are included in the Zip file. 

When you select eTransmit from the Sheet Set context menu, the list of files to include in the eTrans- 
mit file is automatically populated with the files from the current sheet set. This means that you don’t 
have to build the list of drawings manually for the eTransmit file. 

If you need to make setting changes for the eTransmit feature, you can do so by selecting the 
Transmittal Setups option in the sheet set context  menu. 

Preparing Your Project Files 
Now that you’ve seen how sheet sets work, you can start to use them on your own projects. Sheet sets 
work best when your project files are organized and you have some additional files prepared and on hand. 
Here’s a checklist of things to keep in mind when you start to use sheet sets: 

• Organize your files so that when you import your project into a sheet set, the files will be automati-
cally organized by discipline or sheet number.

• Use only one layout per sheet set drawing file. The Sheet Set Manager uses only one drawing per 
sheet and one layout per drawing.

• Create a template file containing the title block that you want to use for your project. Be sure to 
include any sheet set fields you want to use in the title block attribute definitions. You can also 
include your callout blocks in the template file for convenience.

• Because all the sheets in your project will most likely be printed on the same size sheet with the 
same plot specifications, it helps to create a sheet setup that you can apply to all your sheets. You  
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can store the sheet setup in any drawing file and then use the Sheet Set Properties option to locate 
that file to assign the page setup to the entire sheet set. 

Sheet Sets and Autodesk Vault integration 

Autodesk® Vault is a data management system that enables users of Autodesk products to easily 
share, track, and maintain project files. Autodesk Vault now offers AutoCAD Sheet Set integra- 
tion through the Sheet Set Manager. This means that you can log into an Autodesk Vault account, 
open and check out sheet set files, and have revisions  tracked. 

To learn more about Autodesk Vault, visit www.autodesk.com.

Restore the backup Example Files 

If you want to repeat the exercises in this chapter, you can reset the sheet set sample folders to 
their original state by copying them from the Chapter 28\backup folder into the Chapter 
28 folder.

http://www.autodesk.com/
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